SIEMENS

Desigo V5.1/TRA
Setup & Service Assistant
User Guide

PDF help
Contents

1 Setup & Service Assistant.................................................................4
2 Installing SSA DNT .........................................................................6
3 Connecting the cable to the IP device ........................................7
4 Configuring a network connection ...............................................8
5 Configuring a room automation station ......................................11
6 Establishing web connection to room automation station ..........15
7 Device and network configuration (homepage) .........................17
8 DALI status ..................................................................................19
9 DALI identification .......................................................................21
10 DALI data point test .................................................................24
11 KNX PL-Link identification .........................................................26
12 KNX PL-Link data point test .......................................................27
13 KNX PL-Link not configured .....................................................29
14 TX-I/O status ..............................................................................30
15 TX-I/O data point test ...............................................................31
16 Report .......................................................................................33
17 Configuring router PXG3.M/L ....................................................35
18 Configuring a router ...................................................................36
19 Operating routers .......................................................................40
20 Operating PXG3.W100 Web Server ............................................42
21 Updating firmware ......................................................................43
22 Configuring and reading back via IP connection .......................45
23 Defining proxy server settings ....................................................47
24 SSA-DNT program description ..................................................48
1 Setup & Service Assistant

The Setup & Service Assistant helps install and commission devices on the IP network and on connected field busses.

The Setup & Service Assistant consists of two parts:
- The SSA DNT (Discovery and Node Setup Tool) program.
  Use SSA DNT to configure the IP devices (room automation station, router, etc.) in the (IP) network.
- The website in each IP device (room automation station, router, etc.).
  Configure TX-I/O, PL-Link, and DALI devices using the website on the room automation station. In addition, carry out wiring and data point tests.

Desigo TRA workflow (overview)
For Desigo TRA, electrical installers can configure and test devices on the (IP) network as well as field devices on the field bus (island bus, PL-Link, DALI). The electrical installer receives the required data via a data package (Pack & Go) created in ABT.
See Installing SSA DNT [→6]

Desigo XWP workflow and router
For Desigo XWP, electrical installers can configure the IP devices (e.g. router) in the (IP) network. SSA-DNT is launched directly from XWP.
See Configuring router PXG3.M/L [→35]
**Important/Notes**

All entries are executed directly in the SSA and regularly saved every 15 minutes in non-volatile memory on the room automation station. It is immediately saved with **Save and log out**. No data is saved on the commissioning laptop.
2 Installing SSA DNT

SSA DNT is a part of the Pack&Go data package.

Prerequisite
- The project-specific Pack & Go data package (zip file) is located on the commissioning computer.

Extracting the Pack & Go zip file
1. Double-click the *.zip file.
2. Enter an empty folder as extraction target.
3. Click OK.
   => The configuration data for all engineered room automation stations and routers are saved in the specified folder.

Starting SSA DNT
1. Double-click file SSA-DNT.exe in the unzipped folder (unzip target folder).

   => The network configuration data is read. The engineered room automation stations are displayed. (Select device configuration table).

2. Open a network connection to the room automation station.
   See: Connecting the cable to the IP device [➡ 7]
   See: Configuring a network connection [➡ 8]

Notes:
- A description of the SSA DNT program user interface is available here: SSA-DNT program description [➡ 48]
- The operating system language setting in Regional Settings determines the user interface language of SSA-DNT.
3 Connecting the cable to the IP device

Use a LAN or USB cable to connect the commissioning laptop to the IP device (e.g. room automation station, router, ...).

LAN cable

The LAN cable connects the commissioning laptop with the network (IP) in two ways:

- The LAN cable is plugged in directly to the device.
- The LAN cable is plugged in at another location on the network (IP).

Note: If 24 V power supply to an automation station is interrupted, the switch function of this automation station automatically stops, and IP communication to other automation stations in the communication chain is interrupted.

Prerequisite

- LAN cable Category 5 RJ 45 is available.

Procedure

1. Plug in the LAN cable to the commissioning laptop and IP device.
2. Configure the network connection in the SSA DNT.
   See Configuring a network connection [➙ 8]

USB cable

The USB cable directly connects the commissioning laptop to the IP device. The IP device establishes the additional connection to the network (IP). This has the following effect: The connection between the commissioning laptop and the network (IP) is interrupted (e.g. during configuration, etc.) if the IP device is restarted.

Prerequisite

- USB cable is available (type A plug on one end and type B on the other).
- USB driver RNDIS is installed or exists locally (load via V5, ACS, BIM tool or Internet).

Procedure

1. Plug in the USB cable to the commissioning laptop and IP device.
   - If no USB driver is installed and the Internet is connected, locate the right USB driver and install it using the wizard.
   - Enter the storage location in the wizard if the driver is saved locally.
   - A new USB IP network connection (Siemens USB Remote NDIS Network Device...) is created.
2. Configure the network connection.
   See Configuring a network connection [➙ 8]
4 Configuring a network connection

The commissioning laptop requires a unique IP address in the IP network. In addition, the commissioning laptop and the IP devices (room automation station, router, etc.) must be located in the same subnet for SSA-DNT to detect a device using UDB Multicast. For example:

192.168.251.10, Subnet mask 255.255.255.0
192.168.251.20, Subnet mask 255.255.255.0

The network connection of the commissioning laptop must be configured accordingly. Automatic IP address assignment by a DHCP server does not satisfy this requirement.

Note:
- The existing IP address with subnet mask is key for configured IP devices.
- The IP address with subnet mask (target address) to be configured is key for unconfigured IP devices. This ensures that all devices are located in the same subnet following configuration.

Configuring the commissioning laptop network connection

In the SSA DNT program, network connection settings can be queried directly via the IP settings button (same as Start > Control Panel > Network Connections in the Windows operating system).

Prerequisite
- The IP address with subnet mask is known for the commissioning laptop (ask your project manager).

Procedure
1. Start program SSA-DNT:
   - Double-click file SSA DNT.exe.
   or
   - Select Start > Programs > DESIGO Tools > DESIGO SSA-DNT > SSA-DNT.
2. In the SSA DNT, click IP settings.
   ➜ The Network connections pane opens.
3. Double-click the LAN network interface.
   or
   Double-click the USB network interface (e.g. SBT USB Remote NDIS Network Device...). See: Connecting the cable to the IP device [➜ 7]
   ➜ The Status for dialog box opens.
4. Click **Properties**.

![Image of Local Area Connection Status]

5. Select **Internet Protocol (TCP/IP)**.

   Click **Properties**.

![Image of Local Area Connection Properties]

6. Select **Use following IP address**.

   Click **Advanced**.

![Image of Internet Protocol (TCP/IP) Properties]
7. Click Add.

8. Enter the IP address (IP address range for Desigo TRA). Enter the subnet mask (e.g. 255.255.255.0). Click Add.

9. Confirm by clicking OK and close the dialog box.
   The network connection was assigned another fixed IP address.
5 Configuring a room automation station

Configuring a room automation station comprises the following steps:

- Locate the room automation station on the network.
- Assign the engineered room automation station to the room automation station in the network.
- Configure room automation station (network configuration/node setup and device configuration) and load configuration data (for field bus and field devices).

Note: The project-specific application is loaded using ABT following room automation station configuration.

Prerequisite

- The commissioning laptop is connected to the room automation station (via LAN or USB cable). See Connecting the cable to the IP device [7]
- A network connection (via USB or LAN) is configured. See Configuring a network connection [8]
- The device is operational and unconfigured.
- The project password is known.
  Note: The project-specific password for the data package (Pack & Go) is provided separately to the electrical installer (either by phone or in writing).
- The SSA DNT program is open. SSA-DNT has imported the data package (Pack & Go) configuration data.

Connecting to the network

1. Select the configured network interface.
2. Select the configured IP address.
3. Click Connect.
Configuring a room automation station

- The LAN or USB network connection is established (log entry).
- The status of the network connection is displayed (lower left hand side of the pane).
- For a USB network connection, the connected device is listed immediately in the Select device on network table and can be configured without additional identification.

Note: An active firewall may prevent access to the device. Either the corresponding firewall pane is displayed or no devices are found with Network scan. Not even the service pin triggers a reaction. Check with your network administrator for detailed procedures.

Entering a password
Access to the IP device requires an encrypted project password deliverd as part of the data package (Pack & Go), which is set during device configuration.
Password entry in SSA-DNT results in an automatic background password query.

1. Enter the password (top right).
2. Make sure the password matches the project.

Discovering a room automation station in the network

1. Click Network scan.
   - The network is scanned (log entry).
   - The discovered devices (room automation stations, routers, etc.) are displayed. (Select device on network table).
   - Unconfigured devices are displayed with Message = Unconfigured and device instance number = 4194303.
2. Check to see if the device instance number and address and port differ (for engineered and previously configured devices).

Note: If Network scan does not detect any devices, an active firewall may prevent detection, or the IP address of commissioning laptop and device are not defined within the same subnet.

Configuring a room automation station

1. Press the service pin on the device.
   - The device sends out an identification signal.
   - The device is highlighted in table Select device on network.
     Notes: Only the device matching the last identification signal is highlighted. Flash can also be used for identification.
2. Select the engineered device configuration for the identified (highlighted) device. (Select device configuration table).
   - The device configuration is also selected.
3. Check to see if the identified device (highlighted) should be configured as per the engineered device configuration (highlighted also).
Note: You can only use Configure/load device if the following conditions are met:
- The identified device is NOT configured. (Delete first any existing configuration).
- Device type and serial number of the identified device and the engineered device configuration match.
4. Click **Configure/load device**.

- The configuration data are read by the data package (Pack & Go). An error message is displayed in the log window when the project password is invalid (window top right).
- The identified device (network configuration/node setup) is configured.
- Device configuration and configuration data (for field bus and field devices) is loaded in the room automation station.

- The values in the tables are updated.

**Note:**
- **Configure/load device** requires about 2 to 4 minutes (including device restart).
- If you cannot easily access the service pin, use the **Flash** button to issue a flash command to the highlighted device for identification.
- Multiple devices can be configured in sequence using a LAN connection to the device. You do not need to wait each time for a complete configuration.
- Conversely, in the event of a USB connection, connection to other room automation stations on the network is interrupted if the directly connected room automation station restarts.

**Deleting an existing configuration**

1. Select a room automation station. (**Select device on network** table).

2. Click **Delete device**.

- Note: The project password used to configure the device is required. An error message is displayed in the log window when the project password is invalid (window top right).

- Beginning and end of a procedure is displayed in the log window (takes about 1 to 2 minutes).

- Table **Select device on network** is updated (**Device status** = unconfigured, **Device status** = Download required, **Device name** = Default Name, **Device instance number** = 4194303).

- The room automation station no longer is configured (factory setting).

**Note:**
- Multiple room automation stations can be deleted, one after the other, using a LAN connection to the room automation station. You do not need to wait for deletion to complete.
- Conversely, in the event of a USB connection, connection to other room automation stations on the network is interrupted if the directly connected room automation station restarts.
Making the LED flash on the room automation station

Flash allows you to verify if the highlighted room automation station and the actual room automation station match.

1. Select a room automation station. *(Select device on network table).*

2. Click Flash.
   - An LED of the device flashes for about 10 seconds.
6 Establishing web connection to room automation station

The room automation station has a web server. For this reason, you can access the homepage for the room automation station (URL) via SSA DNT or your browser (e.g. Internet Explorer > 7). You can use the browser to operate and parameterize a room automation station as well as to configure field bus devices.

Establishing a web connection to a room automation station (web server)

Prerequisites
- The room automation station is configured.
- The SSA DNT program is open. The device is connected.

Procedure
1. Click Network scan in SSA-DNT.
   ➡ The discovered devices are displayed in the Select device on network table.
2. Click the link to the room automation station. (Select device on network table; URL Setup & Service Assistant column).
   ➡ The project password (window top right) is checked. If necessary, another password query is displayed.
   ➡ The room automation station overview page (homepage) opens. The most important states and properties of the room automation station and the
establishing web connection to room automation station

3. Select the desired working pane in the top navigation pane.
4. Select a subpane in the left navigation pane.
   Note: The web page language can be set on each web page (top right).

**Web connection using a browser**

If you know the IP address of the room automation station, you can enter the
address in the browser or save it under Favorites. This opens the homepage
without SSA DNT, but you must still enter the password.
Check your proxy server settings for the browser if the status page does not open.
See: Defining proxy server settings [➙ 47]

**Disconnecting a web connection**

1. Check to see if devices or field buses require restarting or if they are in the
desired operating state.
2. Select **Save and log out** in the upper navigation pane.
   Note: All entries are executed directly in the SSA and regularly saved every 15
   minutes in non-volatile memory on the room automation station. It is immediately
   saved with **Save and log out**. No data is saved on the commissioning laptop.
Device and network configuration (homepage)

The Device and network configuration web page shows the operating state and a few configuration properties of the room automation station. You can restart the room automation station or remove all overwritten data points using a command.

Note: All entries are executed directly in the SSA and regularly saved every 15 minutes in non-volatile memory on the room automation station. It is immediately saved with Save and log out. No data is saved on the commissioning laptop.

Prerequisites

- A web connection to the room automation station is available. See also: Establishing web connection to room automation station [➙ 15]

Starting a room automation station

- Click Run to start the room automation station.

Note: If you cannot start the room automation station via Run, restarting using network off/on is possible.

Remove overwrite

The column Override displays whether at least one data point has the status "Overwritten". The command Remove overwrite removes the "Overwritten" state for all data points on this room automation station.

1. Ensure on the individual web pages ... Data point test, whether you want to remove all overwritten data points.

2. Click Remove overwrite.

All overwritten states are removed. No new commands are issued. The set values remain until the next program command. Priority 8 is enabled.
Reading room automation station configuration properties

1. Click **Details** in the left column.
   - The room automation station configuration properties are displayed.

2. The **<Back>** button returns you to the previous web page.
   Or: Select the desired working pane in the top navigation pane.
8 DALI status

The DALI status web page shows the current DALI bus status. Execute the following functions:

- Start and stop the DALI bus.
- Automatically address DALI devices
- Execute DALI command test.

**Prerequisite**

- DALI is selected in the upper navigation pane.
- Status is selected in the left navigation pane.

**Starting or stopping the DALI bus**

- Click Run or Stop.
  
  - The DALI bus is started or stopped, and the status displayed (operational/stopped).

**Restarting the DALI bus**

- Click Reset.
  
  - All DALI devices are reinitialized (runtime configuration, bus configuration).
  - The DALI bus is restarted, and the status is displayed as Operational.
  - The number of configured DALI devices is displayed.

**Automatically addressing DALI devices (short address)**

1. Click Auto addressing.
  
  - The DALI bus is scanned. The DALI devices discovered contain a DALI bus short address. Existing DALI bus addresses remain as is.
  - The ongoing auto addressing and may take a few minutes (depending on the number of DALI devices).
  - Auto addressing does not update the contents of the DALI identification and DALI data point test web pages.

2. Select Identification in the left navigation pane.
Following auto-addressing, the web page **DALI identification** shows the DALI bus short address and the detected DALI device type (device online) in the **Online list**.

**Executing a command test**

The command test is used to switch all connected DALI devices to either OFF, ON, or FLASHING.

- The DALI bus must be stopped. Only then are the commands **All lights on**, **All lights off**, or **Blink all** active.

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>The &quot;Blink all&quot; function may damage lights.</strong></td>
</tr>
<tr>
<td>Check if lights whose lifetime is impacted by blinking are connected. This is required for all lights connected to the DALI bus of this room automation station.</td>
</tr>
</tbody>
</table>

1. Click **Stop**.

2. Click either **All lights on**, **All lights off**, or **Blink all**.
   - The switching status remains active until another function is selected, or until the DALI bus is restarted.

3. Select **Run**.
   - This stops the command test.
   - The DALI bus is started.

Note: This function can also be run using the service pin on the PXC3..A.
9 DALI identification

The DALI identification web page shows the current DALI bus configuration. This is where you configure DALI devices.

Prerequisite
- DALI is selected in the upper navigation pane.
- Identification is selected in the left navigation pane.
- The DALI bus status is Operational.

Configuring (assigning) DALI devices
A DALI device with DALI bus short address is assigned to an engineered DALI data point and configured (e.g. DALI group).

1. In the Online list table, click to identify that DALI device.
   - The DALI device with the DALI bus short address flashes (e.g. lamp on site).

2. Select Reset device parameters during assignment if you first want to use the DALI device factory setting.

3. Drag and drop the DALI bus short address to the table row containing the engineered DALI data point.
   - The factory setting is executed (option).
   - The DALI device with the DALI bus short address sends its serial number. The serial number is entered in the list.
   - The DALI device is configured using the device configuration data stored on the room automation station.
   - The status display changes to Operational.

Note:
The DALI bus address is transferred to ABT following read back of data. The DALI bus short addresses can be listed in ABT via the "DALI report".
Resetting DALI devices

- In the State pane, click \[ \text{X} \].
  - The DALI device is reset. The device includes the assigned short address.
  - The serial number is deleted from the table. The status display goes to Unassigned device.
  - The DALI device is now listed in the Online list.

Website description

- Reset device parameters... Set the factory setting prior to configuring a DALI device.

If an existing DALI installation is integrated in TRA, existing DALI devices may already be configured. Use Reset device parameters during assignment to initialize the factory setting prior to configuring the DALI device and the configuration is loaded.

Online list table

- The Online list table contains all DALI devices with a DALI bus short address that are still unconfigured.

<table>
<thead>
<tr>
<th>Online list table</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>DALI bus short address. Automatically assigned using Auto addressing.</td>
</tr>
<tr>
<td>Device online</td>
<td>Read DALI device type. (Unconfigured).</td>
</tr>
<tr>
<td>0 FL</td>
<td>FluorescentLamps</td>
</tr>
<tr>
<td>1 EML</td>
<td>Lamps EmergencyLighting</td>
</tr>
<tr>
<td>2 HID</td>
<td>HIDischargeLamps</td>
</tr>
<tr>
<td>3 LV</td>
<td>LowVoltageHalogenLamps</td>
</tr>
<tr>
<td>4 IL</td>
<td>IncandescentLamps</td>
</tr>
<tr>
<td>5 CONV</td>
<td>DirectCurrentConverter</td>
</tr>
<tr>
<td>6 LED</td>
<td>LEDModules</td>
</tr>
<tr>
<td>7 SWI</td>
<td>SwitchinFunction</td>
</tr>
<tr>
<td>8 RGB</td>
<td>ColorControl</td>
</tr>
<tr>
<td>9 SEQ</td>
<td>Sequencer</td>
</tr>
<tr>
<td>10 OC</td>
<td>OpticalControl</td>
</tr>
<tr>
<td>13 M-SEN</td>
<td>Movement Sensor</td>
</tr>
<tr>
<td>14 B-SEN</td>
<td>Light Sensor</td>
</tr>
</tbody>
</table>

Table of configured DALI devices

| Show AI | Filters the DALI devices in the table. |
| Search | Searches for the characters in the table. |
| Address | Engineered DALI data point. |
| Device online | Read DALI device type. (Unconfigured). |
| Device offline | Engineered DALI device type. |
| 0 FL | FluorescentLamps (Standard) |
| 0 G-FL | Generic Fluorescent (Desigo TRA) |
| ... | ... |
| Serial number | DALI device serial number. |
| State | DALI device operating state. |
| | Button to delete the configuration. |
| 1-7 / 7 | Pages1-7; button for browsing. |
10 DALI data point test

The **DALI data point test** web page allows you to test the configured DALI devices and note the results (state, comment). Point test carries out On/Off and dimming (%) commands.

**Prerequisite**
- DALI is selected in the upper navigation pane.
- **Data point test** is selected in the left navigation pane.
- The DALI bus status is **Operational**.

**Searching for DALI data points**

The navigation functions ![Image](bottom right) allow for browsing the display. Select the number of data points to display via the number of entries ![Image](top left).

The search function ![Search](top right) searches the table for the desired characters. All DALI data points found are displayed in the list.

**Switching on or off DALI data points**

1. Select the data point's checkbox **Overwrite**.
   - Manual operation with + and - is enabled.
2. Click + or -.
   - The DALI device is switched on or off. The new value is displayed.

**Note:** Symbol ![Symbol](indicates a faulty value. The tooltip contains the cause (out of service or alarm).

**Dimming DALI data points**

1. Select the data point's checkbox **Overwrite**.
   - Manual operation with + and - is enabled.
2. Click + or -.
   - The dimming value is increased or reduced at 10% increments. The new value is displayed.
Results
1. Click the column State.
   Select the applicable test results.

2. Enter the desired commend in column Comment.
   Complete your entries by pressing <ENTER>.
   Note: The comment is transferred to ABT following read back of data.
11 KNX PL-Link identification

The KNX PL-Link identification web page shows the current status of the KNX PL-Link bus along with the configuration of the devices KNX PL-Link. You start/stop the bus and configure devices with KNX PL-Link.

Prerequisite
• PL-Link is selected in the upper navigation pane.
• Identification is selected in the left navigation pane.

Starting or stopping KNX PL-Link
• Click Run or Stop.
  ⇒ The KNX PL link bus is started or stopped, and the status displayed (operational/stopped).
  ⇒ The number of configured devices with KNX PL-Link is displayed.

Restarting KNX PL-Link
• Click Reset.
  ⇒ All devices with KNX PL-Link are reinitialized (runtime configuration, bus configuration).
  ⇒ The KNX PL-Link bus is restarted, and the status is displayed as Operational.
  ⇒ The number of configured devices with KNX PL-Link is displayed.

Configuring device with KNX PL-Link
The device is assigned to an engineered KNX PL-Link data point and configured (using the program button on the device).

1. Click for a KNX PL-Link data point.
  ⇒ The state Wait... is displayed. The room automation station waits for a signal from the device (ca. 90 seconds).

2. Go to the device on site.

3. Press the program button on the device (see the device data sheet).
  ⇒ The status display goes to Device is configured.
  ⇒ The device is configured with the device configuration from the room automation station.
  ⇒ The device transmits its serial number and version.
The status display changes to **Operational**.

**Notes:**
- If only one device with KNX PL-Link is connected to the network, the device is detected and configured automatically.
- If a device cannot be identified, it is added to the **orphan device list**. See also: KNX PL-Link not configured [➙ 29]

---

**12 KNX PL-Link data point test**

The **KNX PL-Link data point test** web page allows you to test the configured KNX PL-Link data points and note the results (state, comment). Point test carries out On/Off commands.

**Prerequisite**
- **PL-Link** is selected in the upper navigation pane.
- **Data point test** is selected in the left navigation pane.
- The KNX PL-Link bus status is **Operational**.

---

**Finding KNX PL-Link data points**

The navigation functions ![🔍🔍](bottom right) allow for browsing the display. Select the number of data points to display via the number of entries ![Show AI ▼](top left).

The search function ![🔍](top right) searches the table for the desired characters. All KNX PL-Link data points found are displayed in the list.
Testing KNX PL-Link data points

1. Select the data point's checkbox **Overwrite**.
   ⇒ Manual operation with + and - is enabled.

2. Click + or -.
   ⇒ The positioning value is increased or reduced in increments of 10%.
   ⇒ The switching value is changed.
   ⇒ The stage value is increased or reduced.
   ⇒ Blinds: (+) up; (-) down.

Note: Symbol ![.alert](https://example.com) indicates a faulty value. Tooltip e.g. Out of Service or Alarm.

Results

1. Click the column **State**.
   Select the applicable test results.

2. Enter the desired commend in column **Comment**.
   Complete your entries by pressing `<ENTER>`.
   Note: The comment is transferred to ABT following read back of data.
13 KNX PL-Link not configured

The KNX PL-Link not configured web page shows the devices with KNX PL-Link that were detected on the KNX PL-Link bus, but not yet configured. This list must be empty to successfully complete KNX PL-Link identification.

Prerequisite

- PL-Link is selected in the upper navigation pane.
- Unconfigured is selected in the left navigation pane.
14 TX-I/O status

The TX-I/O status web page shows the status for the island bus and the TX-I/O devices. You can execute island bus functions.

Prerequisite

- TX-I/O is selected in the upper navigation pane.
- Status is selected in the left navigation pane.

Start or stop island bus

- Click Run or Stop.
  
  The island bus is started or stopped, and the status displayed (Operational/Stopped).

Restarting the island bus

- Click Reset.
  
  All TX-I/O modules are reinitialized (runtime configuration, bus configuration).
  
  The island bus is restarted, and the status is displayed as Operational.
  
  The number of configured TX-I/O modules is displayed.
15 TX-I/O data point test

The Data point test web page allows you to test the configured TX-I/O data points and note the results (state, comment). Point test carries out On/Off/Multistate, and setpoint commands.

Prerequisite
- TX-I/O is selected in the upper navigation pane.
- Data point test is selected in the left navigation pane.
- The island bus status is Operational.

Finding TX-I/O data points

The navigation functions (bottom right) allow for browsing the display. Select the number of data points to display via the number of entries (top left).

The search function (top right) searches the table for the desired characters. All TX-I/O data points found are displayed in the list.

Testing TX-I/O data points

1. Select the data point's checkbox Overwrite.
   - Manual operation with + and - is enabled.
2. Click + or -.
   - AO: The positioning value is increased or reduced in increments of 10%.
   - BO: The switching value is changed.
   - MO: The stage value is increased or reduced.
   - BlsOut: (+) blinds up; (-) blinds down.

Note:
- The symbol indicates a faulty value. The tooltip contains the cause (out of service or alarm).
- The symbol indicates that the data point cannot be overwritten by manual operation (priority 8). A higher priority (1-7) is active.
Results

1. Click the column State.
   Select the applicable test result.

2. Enter the desired commend in column Comment.
   Complete your entries by pressing <ENTER>.
   Note: The comment is transferred to ABT following readback of data.
16 Report

The following reports can be displayed and printed. In addition, export to Excel (.xls) is possible.

Report: Field bus and devices

The report field bus and devices contains detailed information on room automation stations along with all existing field buses.

Device and network configuration

<table>
<thead>
<tr>
<th>Name</th>
<th>Bus state</th>
<th>Devices connected</th>
<th>Devices configured</th>
<th>Reliability</th>
</tr>
</thead>
<tbody>
<tr>
<td>PL Link</td>
<td>Operational</td>
<td>4</td>
<td>1</td>
<td>Device not assigned</td>
</tr>
<tr>
<td>DALI</td>
<td>Operational</td>
<td>3</td>
<td>1</td>
<td>Device not assigned</td>
</tr>
<tr>
<td>TX-LVO</td>
<td>Operational</td>
<td>2</td>
<td>1</td>
<td>Device missing</td>
</tr>
</tbody>
</table>

PL Link

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Version</th>
<th>Description</th>
<th>Serial number</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 FL16000_1_ProfDev_1</td>
<td>G3D123 5555</td>
<td>MW01 2.0</td>
<td>Device not assigned</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 FL16000_2_ProfDev_1</td>
<td>G3D123 5555</td>
<td>MW01 2.0</td>
<td>Device not assigned</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 FL16000_3_ProfDev_1</td>
<td>G3D123 5555</td>
<td>MW01 2.0</td>
<td>Device not assigned</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4 FL16000_4_ProfDev_1</td>
<td>G3D123 5555</td>
<td>MW01 2.0</td>
<td>Device not assigned</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

DALI

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Version</th>
<th>Description</th>
<th>Serial number</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 FL16000_1_ProfDev_1</td>
<td>G3D123 5555</td>
<td>MW01 2.0</td>
<td>Device not assigned</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 FL16000_2_ProfDev_1</td>
<td>G3D123 5555</td>
<td>MW01 2.0</td>
<td>Device not assigned</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

TX-LVO

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Version</th>
<th>Description</th>
<th>Serial number</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 TX-LVO_1_ProfDev_1</td>
<td>G3D123 5555</td>
<td>MW01 2.0</td>
<td>Device not assigned</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6 TX-LVO_2_ProfDev_1</td>
<td>G3D123 5555</td>
<td>MW01 2.0</td>
<td>Device not assigned</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Report: Point test
The report point test contains detailed information on all data points in all existing field buses.

### PL-Link

<table>
<thead>
<tr>
<th>Address</th>
<th>Name</th>
<th>Description</th>
<th>Overwrite</th>
<th>Value</th>
<th>State</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>PL-1 PRA-UXN HIACModelIsaGEO=1.11;</td>
<td>R_0QCMIC_1_FrRgrDomModRU</td>
<td>Present room climate operation for op unit</td>
<td></td>
<td></td>
<td>Comfort</td>
<td></td>
</tr>
<tr>
<td>PL-1 PRA-UXN NumberedSceneLastGEO=1.11;</td>
<td>R_0QCMIC_1_FrScnSel</td>
<td>Present scene selection</td>
<td></td>
<td></td>
<td>Scene 1</td>
<td></td>
</tr>
<tr>
<td>PL-1 PRA-UXN TempRoomSelAboSEfGEO=1.11;</td>
<td>R_0QCMIC_1_FrSpRu</td>
<td>Present setup for room operator unit</td>
<td></td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PL-1 PRA-UXN TempRoomSelAboSEfGEO=1.11;</td>
<td>R_0QCMIC_1_FrSpShifRu</td>
<td>Present shift for room operator unit</td>
<td></td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PL-1 PRA-UXN HIACModelIsaGEO=1.11;</td>
<td>R_0QCMIC_1_FrClmDopModH</td>
<td>Input room climate operating mode</td>
<td></td>
<td></td>
<td>Auto</td>
<td></td>
</tr>
<tr>
<td>PL-1 PRA-UXN EnergyEfficiencyIndicatorGEO=1.11;</td>
<td>R_0QCMIC_1_FrEff</td>
<td>Energy efficiency indicator room</td>
<td></td>
<td></td>
<td>Undersiz.</td>
<td></td>
</tr>
<tr>
<td>PL-1 PRA-UXN EnergyEfficiencyRequestGEO=1.11;</td>
<td>R_0QCMIC_1_FrEffReq</td>
<td>Reset of room energy efficiency indicator</td>
<td></td>
<td></td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>PL-1 PRA-UXN DeviceLockedGEO=1.11;</td>
<td>R_0QCMIC_1_FrLock</td>
<td>Room operator unit</td>
<td></td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PL-1 A8-SAB GEO=1.43;</td>
<td>R_1UF2222_2_9ElBtn</td>
<td>Blinds push button</td>
<td></td>
<td></td>
<td>No action</td>
<td>Not checked</td>
</tr>
<tr>
<td>PL-1 A8-SAB GEO=1.41;</td>
<td>R_1UF2222_1_9ElBtn</td>
<td>Lighting push button</td>
<td></td>
<td></td>
<td>No action</td>
<td>Not checked</td>
</tr>
<tr>
<td>PL-1 A8-SAB GEO=1.42;</td>
<td>R_1UF2222_1_9ElBtn</td>
<td>Lighting push button</td>
<td></td>
<td></td>
<td>No action</td>
<td>Not checked</td>
</tr>
</tbody>
</table>

### DALI

<table>
<thead>
<tr>
<th>Address</th>
<th>Name</th>
<th>Description</th>
<th>Overwrite</th>
<th>Value</th>
<th>State</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>FL_1 StopLightCmd</td>
<td>Lighting command</td>
<td></td>
<td>☑</td>
<td>50.0</td>
<td>Check success</td>
<td>OK</td>
</tr>
<tr>
<td>0</td>
<td>FL_3StopCmd</td>
<td>Lighting command</td>
<td>☐</td>
<td>0.0</td>
<td>Not checked</td>
<td></td>
</tr>
</tbody>
</table>

### TX/I/O

<table>
<thead>
<tr>
<th>Address</th>
<th>Name</th>
<th>Description</th>
<th>Overwrite</th>
<th>Value</th>
<th>State</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.1</td>
<td>R_1TTc</td>
<td>Austemper</td>
<td></td>
<td>0.0</td>
<td>Not checked</td>
<td></td>
</tr>
</tbody>
</table>

Prerequisite:

- **Report** is selected in the upper navigation pane.

### Displaying and printing reports

1. Click 📄.  
   - The information is displayed in tables in a new pane.  
   - The print dialog box opens.

2. Select the PDF printer.  
   - Click OK.  
   - The reports are printed.

### Exporting reports

1. Click 📋.  
   - The File Download dialog box opens.

2. Select open to open the file directly in Excel.
17 Configuring router PXG3.M/L

Use SSA-DNT to configure router PXG3.M/L on the IP network (Node Setup). Afterwards, configure and parameterize the router in either SSA-DNT or a browser. The required SSA-DNT is installed together with Desigo XWP (V5) and Desigo TRA. If a router is installed without Desigo, contact your Regional Branch Office.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
</table>
| Open ports open the possibility to interrupt or hijack communication. Unauthorized access to customer sites may result in system malfunctions or automation stations failures. Possible consequences: High fixing costs and a loss of reputation.  
1. Open only the ports in a firewall (i.e. external switch) that are required for operating of the BACS. All other ports must be closed.  
2. Only enable SNMP in the router if the function is used. |

Router workflow

1. Connecting the cable to the IP device [➙ 7]  
2. Configuring a network connection [➙ 8]  
3. Configuring a router [➙ 36]  
4. Operating routers [➙ 40]

Notes:
- A description of the SSA DNT program user interface is available here: SSA-DNT program description [➙ 48]  
- The operating system language setting in Regional Settings determines the user interface language of SSA-DNT.  
- The web page language can be set on each web page (top right).
Configuring a router

Configuring a router comprises the following steps:

- Locate the router on the network.
- Create a device configuration for the router.
- Configure the router (Node Setup).

Prerequisite

- The commissioning laptop is connected to the router (via LAN or USB cable).
  
- A network connection (via USB or LAN) is configured.
  
- The device is operational and unconfigured.
  
- The project password is known. The project password is set in the router together with the device configuration.
  
- The SSA DNT program is open.

Discovering a router on the network

1. Select the configured network interface.
2. Select the configured IP address.
3. Click Connect:
   - The LAN or USB network connection is established (log entry).
   - The status of the network connection is displayed (lower left hand side of the pane).
   - For a USB network connection, the connected device is listed immediately in the Select device on network table and can be configured without additional identification.
   - Note: An active firewall may prevent access to the device. Either the corresponding firewall pane is displayed or no devices are found with Network scan. Not even the service pin triggers a reaction. Check with your network administrator for detailed procedures.
4. Enter the project password (top right).
   - A background password query is carried out when accessing the device.
5. Click **Network scan**.
   - The network is scanned (log entry).
   - The discovered devices (room automation stations, routers, etc.) are displayed.
     *(Select device on network table).*
   - Unconfigured devices are displayed with **Message** = Unconfigured and **device instance number** = 4194303.

Creating a device configuration for the router

1. Select **Tools > Create configuration for PXG3**... Select the device type as per the router.

2. Enter the configuration data in the **Add router configuration** window.

![Add router configuration window](image)

- **Name**: ...
- **Instance number**: Unique device number within the network.
- **Password**: Project password for this router. Note the following password rules: Minimum 6 characters, case-sensitive.
  Note: The factory password is not accepted.
- **IP address, Network mask**: IP address for the router.
  Note: If the IP address for the router is outside the configured network configuration, another network connection is required for following device configuration.

3. Check if all device configurations and all previously configured devices have different **device instance numbers** and **address and ports**.

4. Click **OK**.
   - A new device configuration is added. *(Select device configuration table).*

Configuring a router

1. Press the service pin on the device.
   - The device sends out an identification signal.
   - The device is highlighted in the **Select device on network** table.
     Note: Only the device of the last identification signal is highlighted at any given time.
     Note: If you cannot easily access the service pin, use the **Flash** button to issue a flash command to the highlighted device for identification. An LED of the device flashes for about 10 seconds.

2. Select the device configuration for the router. *(Select device configuration table).*
3. Check to see if the identified router (highlighted) should be configured as per the selected device configuration (highlighted also).

Note: You can only use **Configure/load device** if the following conditions are met:
- The identified device is NOT configured. (Delete first any existing configuration).
- Device type and serial number of the identified device and the engineered device configuration match.

4. Click **Configure/load device**. Wait until configuration is complete.
   - Configuration is started (log entry).
   - The device is restarted.
   - The values in the tables are updated.
   - Successful configuration is displayed (log entry).

   **Configure/load device** requires about 2 to 4 minutes (including device restart).

Notes:
- An additional password prompt is displayed in the log window when the password is invalid (window top right).
- Multiple devices can be configured in sequence using a LAN connection to the device. You do not need to wait each time for a complete configuration.
- Conversely, in the event of a USB connection, connection to other routers on the network is interrupted if the directly connected router restarts.

Deleting an existing configuration

1. Select a router. (**Select device on network** table).

2. Click **Delete device**.
   - Beginning and end of a procedure is displayed in the log window (takes about 1 to 2 minutes).
   - Table **Select device on network** is updated (**Device status** = unconfigured, **Device status** = Download required, **Device name** = Default Name, **Device instance number** = 4194303).
   - The router no longer is configured (factory setting).

Note:
- An additional password prompt is displayed in the log window when the password is invalid (window top right).
- Multiple routers can be deleted in sequence using a LAN connection to the router. You do not need to wait for deletion to complete.
- Conversely, in the event of a USB connection, connection to other routers on the network is interrupted if the directly connected router restarts.
19 Operating routers

Each router has a web server. Use SSA-DNT or a browser (e.g. Internet Explorer >V7) to access the homepage of the router (URL). Procedure to operate and parameterize a router.

Establishing a web connection to a router (web server)

Prerequisites
- The router is configured.
- The SSA DNT program is open. The device is connected.

Procedure
1. Click Network scan in SSA-DNT.
   ⇔ The discovered devices are displayed in the Select device on network table.
2. Click the link to the router. (Select device on network table; URL Setup & Service Assistant column).
   ⇔ The project password (window top right) is checked. If necessary, another password query is displayed.
   ⇔ The router overview page (homepage) opens.
3. Select a subpane in the left navigation pane.
   ⇔ If necessary, a password query is displayed.
   ⇔ The device and network settings are displayed.
4. Change the properties as required.
5. Select **Save and log out** in the upper navigation pane.

Notes:
- All entries are executed directly in the SSA and regularly saved every 15 minutes in non-volatile memory on the device. It is immediately saved with **Save and log out**. No data is saved on the commissioning laptop.
- The web page language can be set on each web page (top right).

**Web connection using a browser**
If you know the IP address of the device, you can enter the address in the browser or save it under Favorites. This opens the homepage without SSA DNT, but you must still enter the password.

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Possible security issues</strong></td>
</tr>
<tr>
<td>If the factory-set password is still set, enter a new password for the router by reconfiguring the router. See Configuring a router [36]</td>
</tr>
</tbody>
</table>

Check your proxy server settings for the browser if the status page does not open. See Defining proxy server settings [47]
20 Operating PXG3.W100 Web Server

Use SSA-DNT to configure Web Server PXG3.W100 on the IP network (analog router PXG3.M/L). Normally, for operation the PXG3.W100 touch panel operation is used.

Touch panel operation

The link in the program SSA-DNT starts the touch panel operation by default.

The touch panel operation of the PXG3.W100 is opened.

SSA operation

To start the operation, the address in the browser has to be edited from ".../panel/" to ".../ssa/". After checking the password the overview page of the PXG3.W100 is opened.
21 Updating firmware

SSA-DNT can be used to update the firmware of a previously configured IP device (room automation station, router, ...). The configuration remains available (including password). Restart the device.

You can update several devices at the same time.

The firmware of an unconfigured IP device can be updated also when the commissioning laptop is located in the same subnet.

Prerequisite
- The commissioning computer is connected to the network (via LAN or USB).
- The SSA DNT program is open.

Updating firmware

1. Click **Update firmware** (left, vertical).
   - On initial startup, the path to the firmware files must be indicated and is then saved. The path can be changed any time via **Tools > Options**.
   - The Update firmware window opens.

2. Click **Scan network** (bottom, right).
   - The detected devices are displayed. **(Select device on network table)**.

3. Select the **device type**.
   - **Table Select firmware version only displays the firmware data for this device type.**

4. Enter the project password (top right).

5. Select the desired firmware file in the **Select firmware version** table.
   OR
   - Click **Browse**. Search for the desired firmware file.
   Note: Activate an entry row via **Tools > Options** (checkbox: Additional file selection).

6. Select the device you want to update from **Select device on network table**.

7. Click **Upload firmware**.
   - The firmware of the selected device is updated. Restart the device once or several times. The firmware is loaded correctly and completely when the device with the new firmware version is displayed after a **Network scan**.
   - The log window shows all program procedures.
Note: An error message is displayed in the log window if no valid project password has already been entered (top right).

Notes:
- Function Load firmware takes about 2 to 4 minutes (including device restart).
- Multiple devices can be updated simultaneously using a LAN connection to the device. Conversely, in the event of a USB connection, connection to other devices on the network is interrupted if the directly connected device restarts.
22 Configuring and reading back via IP connection

Remote load establishes an IP connection between commissioning laptop and device (automation station, router, etc.). As a result, access via router or Internet is possible (different subnetworks).

This IP connection also allows for reconfiguring the device (device configuration). The configuration parameters of the device can be read back. (Only router PXG3 W100 at this time).

Prerequisite

- The commissioning laptop is connected to the IP network.
- The device (network configuration/node setup; IP address) is configured.
- The SSA DNT program is open.
  - SSA-DNT has imported the data package (Pack & Go) configuration data.
  - The project password is entered.
  - Task Remote load is selected (tasks, left, vertical).
  - The engineered devices are displayed. (Select device configuration table).

Testing IP connection to device

1. Select the desired device.
2. Select Setup and Service Assistant.
   ↪ The device homepage is displayed:
3. Close the browser window.

Reconfiguring a device

1. Select the desired device.
2. Click Configure/load device.
   ↪ Device configuration and configuration data (for field bus and field devices) is loaded in the device.
Program steps display: Login successfully done; Load in progress; Load finished.

Note: You can only use **Configure/load device** if the address and port, device type and serial number of the discovered device matches the engineered device configuration.

**Reading back configuration parameters (only router PXG3 W100 at this time)**

1. Select the desired device.
2. Click **Read back**.

   The configuration parameters of the device are read back and saved as file (.xml) (C:\...). The configuration data of the router can be imported and updated in XWP.
Defining proxy server settings

Disabling DHCP/APIPA (dynamic addressing) can cause problems when opening a web page, as this disables automatic proxy server configuration. Defining a proxy exception for the APIPA range (e.g. for unconfigured automation station or router 169.254.213.44) can resolve the problem.

Defining the APIPA range (e.g. in Internet Explorer)

1. Open Microsoft Internet Explorer:
2. Select Tools > Internet Options.
3. Click the Connections tab.
4. Click LAN settings.
5. Clear Use automatic configuration script.
6. Click Advanced.
7. Enter 169.*.
8. Click OK several times.
   ✗ The browser no longer applies a proxy server to the indicated address range.
24 SSA-DNT program description
Das Programm SSA-DNT (Discovery and Node Setup Tool) has the following program features.

**Menu**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>File &gt; Close</td>
<td>Close the SSA-DNT program.</td>
</tr>
<tr>
<td>Tools &gt; Options</td>
<td>Path to the folder containing the firmware images.</td>
</tr>
<tr>
<td></td>
<td><strong>Additional file selection</strong>: Activates an input row in the Firmware update window to manually select the firmware file.</td>
</tr>
<tr>
<td>Tools &gt; Add new PXG3... configuration.</td>
<td>Opens the <strong>Add router configuration</strong> window.</td>
</tr>
<tr>
<td></td>
<td>A new device configuration can be created for a specified device type (router).</td>
</tr>
<tr>
<td>Help &gt; Contents</td>
<td>Opens the PDF help. Select the language for the PDF help via the operating system's Regional and Language Options.</td>
</tr>
</tbody>
</table>

**Taskbar (left, vertical)**

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set up node</td>
<td>Opens the <strong>Set up node</strong> window.</td>
</tr>
<tr>
<td>Updating firmware</td>
<td>Goes to the <strong>Update firmware</strong> window.</td>
</tr>
<tr>
<td></td>
<td>The entry field opens if no firmware library definition file is found.</td>
</tr>
<tr>
<td>Remote load</td>
<td>Goes to the <strong>Connect to subnetwork</strong> window.</td>
</tr>
</tbody>
</table>
**Set up node window**

**Network connection**
- Select the network interface.
- See also: Connecting the cable to the IP device [→ 7]

**IP settings**
- Open the pane **Network connections** with the existing network connections and wizard for new connections. 
  See also: Configuring a network connection [→ 8]
- Select IP.

**Connect / Disconnect**
- Connects/disconnects a network connection (IP).

**Security**
- Password
  - Project password to access the IP device.
  - The project password is checked automatically when a connection is established (as project manager).
The **Select device configuration** table shows the available device configurations. The device configurations for a TRA project are read from Pack & Go. The device configuration for the router can be created in SSA-DNT (Tools > Add new PXG3... configuration).

<table>
<thead>
<tr>
<th>Select device configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
</tr>
<tr>
<td>Device name</td>
</tr>
<tr>
<td>Device type</td>
</tr>
<tr>
<td>Address and port</td>
</tr>
<tr>
<td>Serial number</td>
</tr>
<tr>
<td>Device instance number</td>
</tr>
</tbody>
</table>

Right-click a cell to display the following context menu.

<table>
<thead>
<tr>
<th>Context menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find the proper serial number.</td>
</tr>
<tr>
<td>Find the proper device type.</td>
</tr>
</tbody>
</table>

The **Select device on network** table (Desigo TRA only, no Desigo V5 automation stations) displays all IP devices (room automation stations, routers, etc.) on the (IP) network.

The table values are updated upon a network scan, after pressing the service button on the device, or by configuring the device.

<table>
<thead>
<tr>
<th>Select device on network</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message</td>
</tr>
<tr>
<td>Configured</td>
</tr>
<tr>
<td>Unconfigure</td>
</tr>
<tr>
<td>Service pin pressed</td>
</tr>
<tr>
<td>Time set Configuring Restarting</td>
</tr>
<tr>
<td>Authentication failed</td>
</tr>
<tr>
<td>Device status</td>
</tr>
<tr>
<td>Ready for operation</td>
</tr>
<tr>
<td>Receive wink.</td>
</tr>
<tr>
<td>Download required</td>
</tr>
<tr>
<td>Location</td>
</tr>
<tr>
<td>Device name</td>
</tr>
<tr>
<td>Device type</td>
</tr>
</tbody>
</table>
**Select device on network**

<table>
<thead>
<tr>
<th><strong>Firmware version</strong></th>
<th>Firmware version of the device (device-specific).</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Address and port</strong></td>
<td>Engineered IP address and UDP port (configured).</td>
</tr>
<tr>
<td><strong>Serial number</strong></td>
<td>Serial number (specific to the device).</td>
</tr>
<tr>
<td><strong>MAC address</strong></td>
<td>MAC address (device-specific).</td>
</tr>
<tr>
<td><strong>Device instance number</strong></td>
<td>...</td>
</tr>
<tr>
<td></td>
<td>4194303</td>
</tr>
<tr>
<td><strong>URL Setup &amp; Service Assistant</strong></td>
<td>http://...</td>
</tr>
</tbody>
</table>

The filter limits the network search to the selected device type.

**Filter**

<table>
<thead>
<tr>
<th><strong>Filter criteria for the network.</strong></th>
<th>Device type selection.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Refresh</strong></td>
<td>Searches for the selected device type on the network and lists the devices in the Select device on network table.</td>
</tr>
</tbody>
</table>

**Button**

<table>
<thead>
<tr>
<th><strong>Read back</strong></th>
<th>Reads the configuration parameters of the selected IP device and saves them to a file. (Only router PXG3 W100 at this time).</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Configure/load device</strong></td>
<td>Configure both network (node setup) and device. Load the configuration data (for field bus and field devices) in the room automation station. Prerequisite: The device is not configured, device type and serial number match. See: Configuring a room automation station [➙ 11] See: Configuring a router [➙ 36]</td>
</tr>
<tr>
<td><strong>Delete device</strong></td>
<td>Delete network configuration, device configuration, and configuration data in the device (factory setting). See: Configuring a room automation station [➙ 11] See: Configuring a router [➙ 36]</td>
</tr>
<tr>
<td><strong>Scan network</strong></td>
<td>Scan the (IP) network to discover all IP devices (room automation stations, routers, etc.) and display them in the Select device on network table (Desigo TRA only, no Desigo V5 automation stations). See: Configuring a room automation station [➙ 11] See: Configuring a router [➙ 36]</td>
</tr>
</tbody>
</table>

**Log window**

Shows the individual steps carried out in the program.

**Status display** (lower left hand edge of pane).

Shows the connection status between commissioning computer and network (IP).
"Update firmware" window

**Filter**

| Select device type | Searches for the selected device type on the network and lists the devices in the Select device on network table. The selectable device types are dependent on whether or not a firmware file exists for the device type. (Tools > Options) |

**Security**

| Password | Project password to access the IP device. The project password is checked automatically when a connection is established (as project manager). |

**Select firmware version**

| Firmware version | Firmware version in the firmware image. |
| File name | File name for the firmware image. |
| Release info | Release information for the firmware image. |
The entry field **Select firmware file manually** must be enabled via **Tools > Options**: Additional file selection.

<table>
<thead>
<tr>
<th>Select firmware file manually</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entry field</td>
</tr>
<tr>
<td>Browse</td>
</tr>
</tbody>
</table>

The **Select device on network** table (Desigo TRA only, no Desigo V5 automation stations) displays all IP devices (room automation stations, routers, etc.) on the (IP) network.

<table>
<thead>
<tr>
<th>Button</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Loading firmware</strong></td>
<td>Loads the firmware in the selected device. Start and end of loading are logged in the log file. See Updating firmware [43]</td>
</tr>
<tr>
<td><strong>Scan network</strong></td>
<td>Scan the (IP) network to discover all IP devices (room automation stations, routers, etc.) and display them in the <strong>Select device on network</strong> table (Desigo TRA only, no Desigo V5 automation stations).</td>
</tr>
</tbody>
</table>

**Log window**
Shows the individual steps carried out in the program.

**Status display** (lower left hand edge of pane).
Shows the connection status between commissioning computer and network (IP).
Shows the connection status between commissioning computer and network (IP).
Remote load window

Security

| Password | Project password to access the IP device. The project password is checked automatically when a connection is established (as project manager). |

Select device configuration

<table>
<thead>
<tr>
<th>Location</th>
<th>Engineered description of the device's mounting location.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device name</td>
<td>Engineered device name.</td>
</tr>
<tr>
<td>Device type</td>
<td>Engineered device type.</td>
</tr>
<tr>
<td>Address and port</td>
<td>Engineered IP address and UDP port.</td>
</tr>
<tr>
<td>Serial number</td>
<td>Device serial number saved in the project.</td>
</tr>
<tr>
<td>Device instance number</td>
<td>Engineered device instance number.</td>
</tr>
</tbody>
</table>
Log window
Shows the individual steps carried out in the program.

Status display (lower left hand edge of pane).
Shows the connection status between commissioning computer and network (IP).